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摘要 

    量子點以水熱法合成，反應物是檸檬酸與乙二胺，反應條件為 150℃、2.5 小時，經透析

膜純化後，得黑褐色液體。有廷得耳效應，紫外光可見光譜最大吸收波長 340 奈米，而在紫

外燈下，會發出藍色螢光，且螢光放射波長 460 奈米，是以碳為主要組成原子的量子點。利

用牙膏盒、空白 DVD 片、數位相機、積木與紫外燈，結合電腦軟體 Image J 分析影像與 Excel，

自製螢光光譜儀，可測得量子點螢光放射波長 450 奈米，非常接近實際值。再以自製螢光光

譜儀研究，發現量子點在含酒精或離子強度強的鹽類水溶液，如氯化鋇、氯化鈣，螢光強度

會增強；水溶液 pH 值小於 5 或大於 9 或在硫酸銅溶液螢光會降低，故需調整溶液 pH 值在 7

附近，使螢光恢復。 

壹、研究動機 

    老師在介紹「光」這個單元時〔1〕，說明發光體有太陽、燭光、螢光、…等，其中「螢光」，

不像太陽與燭光有光也有熱，並非主動發光體，而是「光致發光」，本身並不放出熱量，所

以是一種冷發光。當某種常溫物質經某種波長（紫外光或 X 光）的入射光照射，在吸收能量

較高的光源後，電子會產生能階躍升，而當電子從高能階的狀態降到低能階的狀態時，立 

 
 

圖一 螢光發光機制 
圖二 不同尺寸的硒化鎘(CdSe)量子點在紫

外線的照射下發出螢光〔3〕 

即退激發並發射出波長較長的光（通常波長比入射光的的波長長，在可見光波段，螢光發光

機制如圖一）；而且一旦停止入射光，發光現象也隨之立即消失。近年來的文獻報導〔2〕，有

https://zh.wikipedia.org/w/index.php?title=%E7%A1%92%E5%8C%96%E9%95%89&action=edit&redlink=1
https://zh.wikipedia.org/wiki/%E9%87%8F%E5%AD%90%E7%82%B9
https://zh.wikipedia.org/wiki/%E5%8F%AF%E8%A7%81%E5%85%89
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一種會產生「螢光」的材料，稱為「量子點」，由少量的原子所構成，其尺寸都在 100 奈

米(nm)以下，外觀恰似一極小的點狀物，是一種奈米級材料，在吸收能量較高的紫外線光

源後，會發射出波長較長的光，如圖二〔3〕不同尺寸的硒化鎘（CdSe）量子點在紫外線的照

射下發出螢光。不但如此，「量子點」具有螢光亮度強、光穩定性佳、以及利用單一波長

的紫外光燈源，便可以激發出多種不同波長的光波之特性，且可重複激發，因此螢光時效

可以持久。這些特性吸引我們對「量子點」的發光很好奇，翻閱文獻，我們想用簡易的方法，

合成出「量子點」，並以現有的器材，利用螢光偵測原理，設計簡易螢光光譜儀，研究「量

子點」的螢光性質。 

貳、研究目的 

一、量子點的合成 

二、製作簡易螢光光譜儀 

三、量子點的光學性質研究 

四、以自製螢光光譜儀測量分析量子點在不同溶劑、酸性、鹼性及金屬離子溶液的螢光光譜 

參、研究設備及器材 

一、研究設備 

1. 電子天平 1 台 ；2. 刮勺 2 支 ；3. 稱量紙 50 張 ；4. 濾紙 1 盒；5. 水銀溫度計 1 支 ；

6. 攪拌加熱器 1 台 ；7. 鐵鍋 1 個 ；8. 壓力釜 1 只 ；9. 樣本瓶 20mL 20 個 ；10. 紫外燈

燈（有 250nm、360nm ） 1 台；11. 滴管 10 支 ；12. 燒杯 1000mL 1 個 ；13. 燒杯 500mL 2

個 ；14. 燒杯 100mL 10 個 ；15. 雷射筆 1 支；16. 空白 DVD 1 盒 ；17. 剪刀 1 把 ；18. 脫

脂棉花 1 包 ；19. 牙膏盒 1 個 ；20. 黑色膠帶 1 捆 ；21. 方形玻璃試管 4 個 ；22. 廣用試

紙 1 盒 ；23. 樂高積木 1 盒 ；24. 透析膜 Spectra/Por Dialysis Membrane Biotech CE Trial Kit 

MWCO:0.5-1 kD  1 捆 ；25. 攪拌子 1 個 ；26. 透析膜專用夾子 2 個 ；27. 數位照相機 1 台 ；

28. 照相機腳架 1 台 ； 29. 影像分析軟體 Image J；30. 數據分析軟體 Excel；31. 紫外光可見

光光譜儀（Agilent 8453 UV/VIS Spectrometer）；32. 離心機 1 台；33. 離心管 6 支 34. 螢光光

譜儀（Hitachi F-7000 Fluorescence Spectrophotometer） 

二、研究藥品 

1. 檸檬酸 ；2. 乙二胺 ；3. 氯化鈣 CaCl2 2H2O 500g 1 瓶 ；4. 硝酸鉀 KNO3 500g 1 瓶；5. 氯

化鋇 BaCl2 500g 1 瓶；6. 六水合硫酸銨亞鐵 Fe(NH4)2(SO4)2 6H2O 500g 1 瓶；7. 硫酸銅

CuSO4 5H2O 500g 1 瓶；8. 硫酸銨(NH4)2SO4 500g 1 瓶；9. 氯化鈉 NaCl 500g 1 瓶； 10. 硝酸鉛

Pb(NO3)2 500g 1 瓶；11. 硫酸鋅 ZnSO4 500g 1 瓶  ；12. 矽油 500mL 3 瓶； 13. R.O 逆滲透水 14.

藥用酒精 95° 500mL  

https://zh.wikipedia.org/w/index.php?title=%E7%A1%92%E5%8C%96%E9%95%89&action=edit&redlink=1
https://zh.wikipedia.org/wiki/%E9%87%8F%E5%AD%90%E7%82%B9
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肆、研究過程或方法 

我們將實驗分成三部分，分別為量子點的合成、製作簡易螢光光譜儀及量子點性質的研究： 

一、量子點的合成 

（一）量子點的合成 

量子點的種類有多種，在研究動機中介紹的量子點，是屬於無機物的量子點，而我們所

感興趣的，是有機物量子點，因為無毒且主要組成的原子為碳，又可稱為碳量子點。近年來，

合成碳量子點有多種方法，雷射剝蝕法、化學合成、熱分解、微波法和水熱法，其中，本次

的研究是採用水熱法。水熱法是指反應於高壓釜中進行，如圖三（釜體不鏽鋼、圓形樺槽、 

  

圖三 高壓釜的組成元件 圖四 水熱法 

鋼製螺旋、內膽為四氟乙烯）所示，將反應物（含有碳的物質，如蔗糖、麵粉、果汁、檸檬

酸等碳水化合物）配置成水溶液在密閉容器內，利用油浴鍋及加熱板，可將溫度調至數百度，

隨著對高壓釜加熱，釜內的溫度的上升並且壓力增加（如圖四）。水溶液在高壓、高溫的環境，

就能促使水溶液中含碳的物質反應生成量子點，由於不經過高溫煅燒，可避免量子點再次聚

集，變成巨大碳粒。 

1. 稱取 0.315g 的檸檬酸、量取水 25mL 及 1mL 的乙二胺〔4,5,6〕，溶液呈無色透明，一起放入聚

四氟乙烯罐中。 

2. 反應釜體下墊片向下，放入聚四氟乙烯罐與上墊片，先擰緊釜蓋，然後用螺桿把釜蓋旋扭

擰緊釜蓋，然後用螺桿把釜蓋旋扭擰緊為止。 

3. 將水熱合成反應釜置於矽油鍋，以加熱板加熱，調整加熱速度，於 30 分鐘後，矽油鍋內溫

度到達 150℃，再繼續加熱 2.5 小時。 

4. 停止加熱後，等到裝置回到室溫，用螺桿把釜蓋旋扭扭開，打開釜蓋，為黑褐色溶液。 

5. 以玻棒沾取一點黑褐色溶液，點於濾紙上，等待濾紙乾後，放在暗處，以紫外燈照射，觀

察是否有螢光產生。 

（二）量子點的純化 

1. 本次量子點的純化，是利用透析膜，透析膜的外觀很像塑膠袋，透析膜的原理〔7〕，是利用
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分子會從高濃度擴散到低濃度，待透析物放在具分子大小選擇性的透析膜中，進行物質交換，

此時大分子的溶質會被保留，而小分子溶質會通過透析膜移除，最終達到去除的效果（圖五）。 

2. 本次的實驗，我們所要的量子點，就是大分子，而那些在高壓釜反應後，若生成物是小的 

 

圖五 透析膜的原理〔7〕 

分子，不是我們所要的量子點等級（1-100 奈米），或是未反應完的起始物如乙二胺或是檸檬

酸，都可藉由透析膜（所使用的透析膜規格 MWCO:0.5-1 kD，分子量在 500-1000 的小分子）

移除。 

3. 量取透析模長度 10 公分並剪下（圖六），一端開口端，以寬 3mm 捲三層，以夾子夾住為下 

  

圖六 量取透析膜 圖七 放入產物 

  

圖八 透析裝置 圖九 透析過程 
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端，將此端封住。再將（一）中，從高壓釜合成的黑褐色液體，以滴管取約 5 毫升於此透析 

膜內（圖七），再將上端開口處，以寬 3mm 捲三層，以夾子夾住上端封住（圖八）。 

4. 取一杯裝有 800mL 逆滲透水的燒杯，放入攪拌子，置於攪拌器上，再放入 3.透析膜，調整 

攪拌速度到最低，透析 24 小時（圖九）。 

5. 經過 24 小時後，鬆開夾子，以乾淨滴管吸取透析膜內的液體，放入樣本瓶中，另取一樣本

瓶，放入為透析後的產物，將兩者以紫外燈波長為 365 奈米照射，比較透析前後，螢光是否

相同。 

二、自製螢光光譜儀製作 

    市售的螢光光譜儀，不屬於國中實驗室的設備，搜尋相關的文獻，我們改良文獻中上的

方法，以下的步驟（一）、（二）、（三），製作簡易螢光光譜儀〔8,9,10,11〕 

（一）穿透式分光器的製作 

1. 取一市售牙膏盒，在中點處，劃一直線，量角器量取 60°斜角，畫上斜線記號，以美工刀切 

  

圖十 市售牙膏盒斜切 60°斜角 圖十一 右半部分市售牙膏盒轉成另一方向 

割所畫記處，如此將牙膏盒分成兩部分（圖十）。 

2. 取一全新空白 DVD 光碟片，以剪刀將 DVD 剪開，把原先黏一起的 DVD 分開，我們要的

是塗有紫色染料透明塑膠那一片，棉花沾酒精，把染料除去（圖十二）。 

3. 在 DVD 上，剪下寬 3 公分，長 4.5 公分（圖十三），黏貼在步驟 1.中，其中的一個長端斜 

  

圖十二 裁切光碟片 圖十三 光柵大小（3cm *4.5cm） 
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角 30°開口的牙膏盒（圖十一），以黑色膠帶固定。 

4. 同時在該牙膏盒頂端平面，以美工刀劃開一寬 0.5mm，長 2.5cm 狹縫（圖十四）。 

5.另一部分的牙膏盒，以美工刀剪去頂端部分的盒蓋，開口端以斜角 60°，與步驟 3.中的開口

端斜角 60°相接，以黑色膠帶固定黏好，避免漏光，原來長方型的牙膏盒，就呈 120°的夾角，

穿透式分光器就製作完成（圖十五）。 

（二）自製螢光光譜儀 

1. 準備一水果箱，內部貼滿黑紙，就成為暗箱。 

2. 將（一）分光器接在數位相機的鏡頭前上，數位相機為光譜偵測器，並以黑色膠布黏好，

相機底部以腳架鎖好固定，調整高度與桌面等高。 

3. 以樂高積木組合樣品槽與照光平台，設計兩者在上下垂直位置，照光平台在上，樣品槽在

下（圖十六螢光儀前端）。 

  

圖十六 螢光儀前端 圖十七 螢光儀後端 

4. 樣品槽中放入玻璃方形試管，將分光器狹縫調整恰好緊貼在玻璃方形試管的長面上，如此，

照光、樣品與偵測器三者就會互相垂直。 

  

圖十四 劃開狹縫大小 圖十五 穿透式分光器 
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5. 當樣品是光致發光物質時，照光的光源為紫外燈，即可看到螢光，而偵測器是由分光器連

接數位相機，可拍攝螢光分光後的光色帶（圖十七螢光儀後端）。 

（三）校準光譜儀〔10,11〕 

1. 開啟裝有螺旋式省電燈泡檯燈之電源，並將接有數位相機的分光器，其狹縫對準燈源，按

下快門，拍攝記錄省電燈泡之色帶中明顯的亮線，將此照片檔案，輸入電腦中。 

2. 下載影像分析軟體 Image J。 

3. 開啟 Image J，在 File 處，選擇 Open，開啟 1.中的省電燈泡之色帶照片（圖十八）。 

4. 使用矩形工具，選取一長方形範圍，工具列 Edit → Selection →Specify，設定矩形位置及

大小（表一）。並再次選取工具列 Analyze → Plot Profile，如此就可以得到橫軸為位置像素，

縱軸為強度的省電燈泡光譜圖（圖十九）。 

表一 設定矩形位置及大小參數 

項目 數值 

Width 940 

Height 192 

X Coordinate 1352 

Y Coordinate 1428 

5. 在圖十九中，找到最左端的波峰座標數字（168, 125），最右端的波峰座標數字（685, 72.5）。 

6. Image J 的工具列中，選 Analyze → Tools → Curve Fitting，清除欄位的數字，再輸入 168  

436.6，換行輸入 685  611.6，選 Fit ，得線性函數 y= 0.33849x +379.73346，因為省電燈泡藍光

波長 436.6nm，紅光波長 611.6nm，就可以將橫坐標的位置像素轉換成波長。 

7. 將圖十九 x、y 數據全選，複製，並開啟另一軟體 Excel，將數據貼上，A 欄的數據，以 y= 

0.33849x +379.73346 的比例，轉成在 C 欄，並將 B 欄的數據貼在 D 欄。 

  

圖十八 省電燈泡色帶照片 圖十九 Image J 繪出省電燈泡光譜圖 

8. 選取 C、D 欄數據，選取工作列的插入→散佈圖，即可得已校準波長其橫坐標為波長，縱

座標為強度之省電燈泡之光譜圖（圖二十）。我們就是以省電燈泡發出特定波長的色光，作為
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標準光譜。日後所有樣品拍攝照片其矩形的選取範圍，為表一中設定矩形位置及大小參數，

即省電燈泡照片為基準，並且疊圖，再以 Image J 及 Excel 處理，就可以校正樣品的光譜波長

所在位置 。 

 

圖二十 省電燈泡之光譜圖 

三、量子點性質的研究 

    將在透析膜透析 24 小時後中的黑褐色液體產物倒出，以樣本品保存於陰暗中，產物皆以

滴管量取，而產物為量子點性質的研究，依序為量子點在紫外光可見光吸收光譜、螢光光譜

儀放射光譜、量子點的螢光、廷得耳效應與自製螢光光譜儀測量分析量子點在不同溶劑、酸

性、鹼性及金屬離子溶液的螢光光譜。 

（一）量子點的紫外光可見光吸收光譜 

    取 1mL 的黑褐色液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，產物稀釋成 1/50，

溶液呈無色，取 5mL 於方形試管中，放入紫外光可見光吸收光譜儀（Agilent 8453 UV/VIS 

Spectrometer）樣品槽中，測其產物的吸收光譜圖。 

（二）市售螢光光譜儀測量量子點的螢光放射光譜 

    由於產物的紫外光可見光的最大吸收波長為 340 奈米，故螢光光譜儀（Hitachi F-7000 

Fluorescence Spectrophotometer）測量（一）中的樣品時，是以 340 奈米為激發光，測得產物螢

光放射光譜。 

（三）量子點的螢光發光 

1. 取 1mL 的黑褐色液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，即產物稀釋成 1/50，

溶液呈無色，與純水一起照射紫外燈（紫外燈光波長為 365 奈米），比較兩者在紫外燈下的螢

光發光情形。 

（四）量子點的廷得耳效應〔12〕 
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1. 取 1mL 的黑褐色液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，即產物稀釋成 1/50，

溶液呈無色，與純水一起照射雷射光，比較其廷得耳效應。 

（四）測量分析量子點在不同稀釋比例、溶劑、酸性、鹼性及金屬離子溶液的螢光光譜 

(1) 量子點在不同稀釋比例的螢光光譜 

1. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 10mL，即量子點稀釋成

1/10，溶液呈黃褐色，取 5mL 於入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，

以 360nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖二十一）。 

2. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，即量子點稀釋成

1/50，溶液呈淡黃色，以自製螢光儀，拍攝量子點的螢光照片（圖二十二）。 

3. 取 1mL 的量子點液體，放入 100mL 的燒杯中，加水稀釋到體積為 100mL，即量子點稀釋

成 1/100，溶液呈無色，以自製螢光儀，拍攝量子點的螢光照片（圖二十三）。 

4. 取 1mL 的量子點液體，放入 250mL 的燒杯中，加水稀釋到體積為 200mL，即量子點稀釋

成 1/200，溶液呈無色，以自製螢光儀，拍攝量子點的螢光照片（圖二十四）。 

5. 取 1mL 的量子點液體，放入 500mL 的燒杯中，加水稀釋到體積為 500mL，即量子點稀釋

成 1/500，溶液呈無色，以自製螢光儀，拍攝量子點的螢光照片（圖二十五）。 

     

圖二十一 圖二十二 圖二十三 圖二十四 圖二十五 

6. 開啟 Image J，在 File 處，選擇 Open，開啟 1.至 5.中的量子點之螢光照片與省電燈泡之線光

譜圖照片。 

7. 在工具列 Image → Stacks → Images to Stack，將 6.中的照片疊在一起，得一 stack 的檔案。 

8. 使用矩形工具，選取一長方形範圍，工具列 Edit → Selection →Specify，設定矩形位置及

大小（表一）。 

9. 再次選取工具列 Analyze → Plot Profile，如此就可以得到橫軸為位置像素，縱軸為強度的

省電燈泡光譜圖（圖十九）。 

10. 在圖十九中，找到最左端的波峰座標數字（168, 125），最右端的波峰座標數字（685, 72.5）。 

11. Image J 的工具列中，選 Analyze → Tools → Curve Fitting，清除欄位的數字，再輸入 168 

436.6，換行輸入 685 611.6，選 Fit ，得線性函數 y= 0.33849x +379.73346，因為省電燈泡中有

汞，汞的激發光中藍光波長 436.6nm，紅光波長 611.6nm，就可以將橫坐標的位置像素轉換成

波長。 

12. 將圖十九 x、y 數據全選，複製，並開啟另一軟體 Excel，將數據貼上，A 欄的數據，以 y= 

0.33849x +379.73346 的比例，轉成在 C 欄，並將 B 欄的數據貼在 D 欄。 

13. 滑鼠點到 8.中 Duplicate 的第二張圖，為量子點稀釋 1/10，鍵盤同時按 Ctrl+A，就可得橫軸
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為像素，縱軸為螢光強度的量子點稀釋 1/10 螢光光譜圖，由於像素的位置比例與省電燈泡是

一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 E、F 欄位，刪除 E 欄位。 

14. 滑鼠點到 8.中 Duplicate 的第三張圖，為量子點稀釋 1/50，鍵盤同時按 Ctrl+K，就可得橫軸

為位置像素，縱軸為螢光強度的量子點稀釋 1/50 螢光光譜圖，由於像素的位置比例與省電燈

泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 F、G 欄位，刪除 F

欄位。 

15. 滑鼠點到 8.中 Duplicate 的第四張圖，為量子點稀釋 1/100，鍵盤同時按 Ctrl+K，就可得橫

軸為位置像素，縱軸為螢光強度的量子點稀釋 1/100 螢光光譜圖，由於像素的位置比例與省電

燈泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 G、H 欄位，刪

除 G 欄位。 

16. 滑鼠點到 8.中 Duplicate 的第五張圖，為量子點稀釋 1/200，鍵盤同時按 Ctrl+K，就可得橫

軸為位置像素，縱軸為螢光強度的量子點稀釋 1/200 螢光光譜圖，由於像素的位置比例與省電

燈泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 H、I 欄位，刪除

H 欄位。 

17. 滑鼠點到 8.中 Duplicate 的第六張圖，為量子點稀釋 1/500，鍵盤同時按 Ctrl+K，就可得橫

軸為位置像素，縱軸為螢光強度的量子點稀釋 1/500 螢光光譜圖，由於像素的位置比例與省電

燈泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 I、J 欄位，刪除

I 欄位。 

18. 選取 C 到 I 欄數據，選取工作列的插入→散佈圖，即可得已校準波長其橫坐標為波長，縱

座標為螢光強度之量子點在不同稀釋比例之螢光光譜圖。 

(2) 量子點在不同溶劑的螢光光譜 

1. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，即量子點稀釋成

1/50，溶液呈黃褐色，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，

以 360nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖二十六）。 

2. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取 5mL 酒精加入，即量子點的

濃度與量子點稀釋成 1/50 是一樣的，並且溶劑中有一半是酒精，取 5mL 放入方形試管中，再

放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光

照片（圖二十七）。 

3. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔HCl〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔HCl〕=0.1M，取 5mL 放入方形

試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝量

子點的螢光照片（圖二十八）。 
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4. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔NaOH〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔NaOH〕=0.1M，取 5mL 放入方

形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝

量子點的螢光照片（圖二十九）。 

5. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔Pb(NO3)2〕=0.2M，5mL 加

入，即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔Pb(NO3)2〕=0.1M，取 5mL

放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，

拍攝量子點的螢光照片（圖三十）。 

     

圖二十六 圖二十七 圖二十八 圖二十九 圖三十 

6. 將圖二十六到圖三十轉換成光譜圖，其步驟如上(1)中步驟 6.至 18.，即得量子點在不同溶

劑的螢光光譜。 

(3) 量子點在不同酸性濃度的螢光光譜 

1. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，即量子點稀釋成

1/50，溶液呈黃褐色，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，

以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖三十一）。 

2. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔HCl〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔HCl〕=0.1M，玻棒沾取該溶液，

以廣用試紙測其 pH 值=1，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外

燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖三十二）。 

3. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔HCl〕=0.02M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔HCl〕=0.01M，玻棒沾取該溶

液，以廣用試紙測其 pH 值=5，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的

紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖三十三）。 

4. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔HCl〕=0.002M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔HCl〕=0.001M，玻棒沾取該溶

液，以廣用試紙測其 pH 值=7，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的
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紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖三十四）。 

5. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔HCl〕=0.0002M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔HCl〕=0.0001M，玻棒沾取該

溶液，以廣用試紙測其 pH 值=7，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上

的紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖三十五）。 

     

圖三十一 圖三十二 圖三十三 圖三十四 圖三十五 

6. 將圖三十一到圖三十五轉換成光譜圖，其步驟如上(1)中步驟 6.至 18.，即得量子點在不同

酸性濃度的螢光光譜。 

(4) 量子點在不同鹼性濃度的螢光光譜 

1. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，即量子點稀釋成

1/50，溶液呈黃褐色，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，

以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖三十六）。 

2. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔NaOH〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔NaOH〕=0.1M，玻棒沾取該溶

液，以廣用試紙測其 pH 值=9，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的

紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖三十七）。 

3. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔NaOH〕=0.02M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔NaOH〕=0.01M，玻棒沾取該溶

液，以廣用試紙測其 pH 值=9，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的

紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖三十八）。 

4. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔NaOH〕=0.002M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔NaOH〕=0.001M，玻棒沾取該

溶液，以廣用試紙測其 pH 值=8，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上

的紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖三十九）。 

5. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔NaOH〕=0.0002M，5mL 加

入，即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔NaOH〕=0.0001M，玻棒沾
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取該溶液，以廣用試紙測其 pH 值=7，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品

槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖四十）。 

     

圖三十六 圖三十七 圖三十八 圖三十九 圖四十 

6. 將圖三十六到圖四十轉換成光譜圖，其步驟如上(1)中步驟 6.至 18.，即得量子點在不同鹼

性濃度的螢光光譜。 

(5) 量子點在酸鹼中和前後的螢光光譜 

1. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，即量子點稀釋成

1/50，溶液呈黃褐色，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，

以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖四十一）。 

2. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，〔NaOH〕=0.4M，2.5mL 加入，再加

入〔HCl〕=0.4M，2.5mL，即量子點的濃度與量子點稀釋成 1/50 是一樣的，玻棒沾取該溶液，

以廣用試紙測其 pH 值=10，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外

燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖四十二）。 

3. 將 2.中的液體，再倒回燒杯中，因為含有量子點的液體，是呈現 pH 值=10 的鹼性溶液，因

此每次加入 0.2mL〔HCl〕=0.4M，玻棒沾取該溶液，以廣用試紙測其 pH 值，直到 pH 值=7，

共加入 1mL，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm

照射，以自製螢光儀，拍攝量子點的螢光照片（圖四十三）。 

   

圖四十一 圖四十二 圖四十三 

4. 將圖四十一到圖四十三轉換成光譜圖，其步驟如上(1)中步驟 6.至 18.，即得量子點在酸鹼

中和前後的螢光光譜。 

(6) 量子點在不同金屬溶液的螢光光譜 

1. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，即量子點稀釋成

1/50，溶液呈黃褐色，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，

以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖四十四）。 

2. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔NaCl〕=0.2M，5mL 加入，
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即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔NaCl〕=0.1M，取 5mL 放入方

形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝

量子點的螢光照片（圖四十五）。 

3. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔Pb(NO3)2〕=0.2M，5mL 加

入，即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔Pb(NO3)2〕=0.1M，取 5mL

放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，

拍攝量子點的螢光照片（圖四十六）。 

4. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔CuSO4〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔CuSO4〕=0.1M，取 5mL 放入方

形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝

量子點的螢光照片（圖四十七）。 

5. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔ZnSO4〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔ZnSO4〕=0.1M，取 5mL 放入方

形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝

量子點的螢光照片（圖四十八）。 

6. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔FeSO4〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔FeSO4〕=0.1M，取 5mL 放入方

形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝

量子點的螢光照片（圖四十九）。 

7. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔(NH4)2SO4〕=0.2M，5mL 加

入，即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔(NH4)2SO4〕=0.1M，取 5mL

放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，

拍攝量子點的螢光照片（圖五十）。 

8. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔CaCl2〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔CaCl2〕=0.1M，取 5mL 放入方

形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝

量子點的螢光照片（圖五十一）。 

9. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成
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1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔KNO3〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔KNO3〕=0.1M，取 5mL 放入方

形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝

量子點的螢光照片（圖五十二）。 

10. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔BaCl2〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔BaCl2〕=0.1M，取 5mL 放入方

形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝

量子點的螢光照片（圖五十三）。 

     

圖四十四 

（量子點） 

圖四十五 

（NaCl） 

圖四十六 

（Pb(NO3)2） 

圖四十七 

（CuSO4） 

圖四十八 

（ZnSO4） 

     

圖四十九 

（FeSO4） 

圖五十 

（(NH4)2SO4） 

圖五十一 

（CaCl2） 

圖五十二 

（KNO3） 

圖五十三 

（BaCl2） 

11. 將圖四十四到圖五十三轉換成光譜圖，其步驟如上(1)中步驟 6.至 18.，即得量子點在不同

金屬溶液的螢光光譜。 

(7) 量子點在不同濃度硫酸銅溶液的螢光光譜 

1. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 50mL，即量子點稀釋成

1/50，溶液呈黃褐色，取 5mL 放入方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，

以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖五十四）。 

2. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔CuSO4〕=0.2M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔CuSO4〕=0.1M，取 5mL 放入方

形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝

量子點的螢光照片（圖五十五）。 

3. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔CuSO4〕=0.1M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔CuSO4〕=0.05M，取 5mL 放入
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方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍

攝量子點的螢光照片（圖五十六）。 

4. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，取 5mL 放入一乾淨 50mL 的燒杯中，再另取〔CuSO4〕=0.02M，5mL 加入，

即量子點的濃度與量子點稀釋成 1/50 是一樣的，並且溶液中〔CuSO4〕=0.01M，取 5mL 放入

方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍

攝量子點的螢光照片（圖五十七）。 

    

圖五十四 圖五十五 圖五十六 圖五十七 

5. 將圖五十四到圖五十七轉換成光譜圖，其步驟如上(1)中步驟 6.至 18.，即得量子點在不同

濃度硫酸銅溶液的螢光光譜。 

(8) 量子點與硫酸銅之混合溶液在離心機離心後的螢光光譜 

1. 取 1mL 的量子點液體，放入 50mL 的燒杯中，加水稀釋到體積為 25mL，即量子點稀釋成

1/25，溶液呈黃色，再另取〔CuSO4〕=0.2M，25mL 加入，量子點的濃度為稀釋成 1/50，並且

溶液中〔CuSO4〕=0.1M，量取 8mL，放入第一支離心管，重複 3 次，共有 4 支，放入離心機

中，逐漸調整增快轉速，當離心機轉速達 5000 rpm 時，使其繼續離心 10 分鐘，而後調整降低

轉速，最後使離心機停止。 

2. 從離心機取出 4 支，並以滴管先取 4 支離心管上層液體 2mL，共 8mL，以滴管取 5mL 放入

方形試管中，再放入樣品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍

攝量子點的螢光照片（圖五十八）。 

3. 以滴管先取 4 支離心管中層液體 2mL，共 8mL，以滴管取 5mL 放入方形試管中，再放入樣

品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖

五十九）。 

4. 以滴管先取 4 支離心管下層液體 2mL，共 8mL，以滴管取 5mL 放入方形試管中，再放入樣

品槽中，打開樣品槽上的紫外燈，以 365nm 照射，以自製螢光儀，拍攝量子點的螢光照片（圖

六十）。 

   

圖五十八（上層） 圖五十九（中層） 圖六十（下層） 

5. 將圖五十八到圖六十轉換成光譜圖，其步驟如上(1)中步驟 6.至 18.，即得量子點與硫酸銅

之混合溶液在離心機離心後的螢光光譜。 
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一、量子點的合成 

（一）量子點是否有螢光（在高壓釜內反應後的產物，未進行純化） 

  

圖六十一 在日光下 圖六十二 黑暗處照射紫外燈 

（二）量子點在透析前後於日光下與紫外燈下比較 

  

圖六十三 左瓶已透析、右瓶未透析（日光） 圖六十四 左瓶已透析、右瓶未透析（紫外燈） 

（三）證明產物是量子點之螢光物質 

 

 

圖六十五（純水、量子點） 圖六十六（純水、量子點） 

1. 照射紫外燈 365 奈米（圖六十五） 

2. 廷得耳效應的觀察（圖六十六） 

3. 量子點的紫外光可見光吸收光譜圖（圖六十七） 

伍、研究結果 
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圖六十七 量子點紫外光可見光吸收光譜圖 

4. 量子點以螢光光譜儀測得的螢光放射光譜圖（圖六十八） 

 
圖六十八 量子點螢光放射光譜圖 

二、量子點性質研究以自製螢光光譜儀測得之螢光光譜 
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圖六十九 不同稀釋比例的量子點螢光光譜圖 
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圖七十一 量子點在不同酸性濃度的螢光光譜 
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圖七十 量子點在不同溶劑的螢光光譜 
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圖七十二 量子點在不同鹼性濃度的螢光光譜 

 

 

 

圖七十三 量子點在酸鹼中和前後的螢光光譜 
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圖七十五 量子點在不同濃度硫酸銅溶液的螢光光譜 
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圖七十四 量子點在不同鹽類溶液的螢光光譜 
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圖七十六 量子點與硫酸銅之混合溶液在離心機離心後取上層中層下層液的螢光光譜 

 

陸、討論 

一、量子點的合成 

（一）量子點的合成 

1. 為了能控制量子點的尺寸及有較高的量子產率，參考文獻〔5〕中的配方，以檸檬酸與乙二胺

為反應物，因為檸檬酸（C6H8O7）含有很多碳，是碳的提供者；乙二胺（C2H4(NH2)2）含氮， 

    （式一） 

為合成量子點上缺陷時提供的氮（式一），選用水熱法合成，在水熱法中，使用高壓釜，高壓

釜可以提供反應時的固定高溫、高壓。本次的反應條件為 150℃高溫 2.5 小時，反應物原先是

無色溶液，產物為黑褐色液體，沾取黑褐色液體點在濾紙上，產物在日光照射下，在濾紙上

是淡黃色，並沒有螢光（如圖六十一）；在黑暗處以紫外燈照射（圖六十二），而產物可發出

強度高的藍光螢光，證明產物具有螢光物質。 
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2. 量子點的顆粒大小為 1-100 奈米，而產物顆粒有大有小，有可能也有未完全反應的起始物，

必須使用透析膜純化，透析膜的外觀很像塑膠袋（本次的實驗，我們採用的規格是 Spectrum 

500-1000），利用分子會從高濃度擴散到低濃度，產物放入透析膜透析，透析膜對粒子大小有

選擇性可進行粒子交換，此時量子點這種大粒子的溶質會被保留在透析膜內，而小分子的溶

質（如檸檬酸、乙二胺及較小的縮合產物）會通過透析膜最終達到移除，其效果才能得到顆

粒大小為 1-100 奈米尺寸的量子點。 

3. 比較產物在透析前後，圖六十三是在日光下，外觀都是黑褐色，有透析的產物，比較清澈；

而圖六十四是在紫外燈下，明顯可以看出有透析的產物，螢光較亮，因為會影響螢光發光物

質已移除。 

（二）證明合成產物是量子點之螢光物質 

1. 在紫外燈下產生的螢光 

    產物在稀釋 1/50 後，與純水一起比較，兩者外觀澄清透明，在暗箱中，照射紫外燈，只

有產物可發出藍色的螢光（圖六十五），證明產物是螢光物質。 

2. 量子點的廷得耳效應觀察 

    當一束雷射光透過膠態溶液，從入射光的垂直方向可以觀察到膠態溶液裡射出另一條光

線，此種現象稱為「廷得耳效應」。「廷得耳效應」可以區別真溶液與膠態溶液的差別，當溶

質的粒徑介於 1-100 奈米時，因為光的散射可以觀察到光徑，但真溶液則無法有此一現象。

使用綠色雷射光照射水與產物（以純水稀釋成 1/50 比例）時（圖六十六），兩者外觀澄清透

明，純水沒有光束，但產物有黃色光束，證明所合成產物為膠態溶液，含有 1-100 奈米的粒

子存在，就為量子點。 

3. 以紫外光可見光的光譜儀所測的量子點吸收光譜圖（圖六十七），其最大的吸收波長為 340

奈米，與文獻的報導〔5〕最大的紫外光可見光吸收波長 350 奈米是一致的。 

4. 由於產物的最大吸收波長為 340 奈米，以此波長作為激發光波長，螢光光譜儀測其螢光最

強放射波長（圖六十八）為 460 奈米，也與文獻的報導〔4,5〕最強的放射波長 454 奈米是一致的。 

由 3，4 的光譜波長證明我們合成的產物是典型的以碳為主要構成原子之量子點，為碳量

子點。 

二、自製簡易螢光光譜儀製作 

量子點在照射紫外燈（波長為 365 奈米）時，會發出藍色的螢光，但是藍色螢光是單色

光嗎？一直是我們很好奇的，直接以螢光光譜儀測量，得知其最大放射強度波長為 460 奈米，

是委託研究機構代測。螢光光譜儀所費不貲，國中並沒有此項儀器，想要測量物質的螢光發

光，不是一件容易的事情，將生活中的用品、材料，將之組合，利用螢光的偵測原理，照光

光源、樣品與樣品、螢光放光兩者互相垂直，並在螢光發射處，放置螢光偵測器，其偵測器

是由自製分光器連接數位相機組成，如圖七十七的設計。 

（一） 自製分光偵測器     
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1. 分光器先以市售的牙膏盒斜切 60°，在斜切的開口處放入穿透式光柵，另一斜切部分反接，

如此入射光與繞射光的夾角呈 120°，因為光柵是空白 DVD 其中透明片，是聚碳酸酯層凹槽，

凹槽的溝槽間距＝720 奈米，選擇省電燈泡做為光源，省電燈泡內含有汞，通電發出的白光

由狹縫進入，經光柵繞射，在牙膏盒的另一開口端，就可以觀測到由左到右，分別為藍光、

綠光、黃光與紅光數條光譜譜線，譜線不是直線，為有規律的彎曲，譜線的間隔距離不因彎

曲改變，這是因為光柵是 DVD 片，同心圓的圓形，放置是左到右即從內圈到外圈，而在另一

開口端接上數位相機，就能記錄觀測到此光譜，如圖十八，再將拍攝到的影像，輸入電腦影

像處理 Image J 軟體。 

 
圖七十七 自製螢光光譜儀示意圖 

（二） 校正光譜 

以市售省電螺旋燈泡在通電後發出的白光來校正光譜，白光經自製的分光器，會發射出

數條特定譜線（線光譜），其影像輸入 Image J 軟體，會得到橫坐標為位置像素，縱座標為光

線強度的光譜圖，如圖十九，再利用已知最左端藍色光譜線，波長 436.6 奈米；最右端紅色光

線，波長 611.6 奈米，這兩條線所在位置像素值，以 Image J 軟體計算，得線性函數，將此一

公式重新以軟體 Excel 分析，將位置像素轉換成波長數值，作圖就可得已校準波長其橫坐標為

波長，縱座標為強度之省電燈泡之標準光譜圖（圖二十），之後所有樣品，皆以省電燈泡的光

譜，定出光譜波長所在位置。 

（三）自製螢光光譜儀裝置 

    以樂高積木組合成基座，放入方形試管，在正上方位置，接上樂高積木，為支撐紫外燈，

而自製分光器狹縫緊貼方形試管的長面玻璃，當樣品放入時，打開紫外燈，含有螢光的物質，

會往四面八方發射出螢光，就可以在數位相機偵測到螢光的分光情形。由於螢光光譜儀最主

要有兩個要素，一是波長位置，另一是強度測量。波長位置在（一）（二）的說明，就可以得

知。而我們是以數位相機拍攝，數位相機會記錄光譜照片的像素（由紅、綠、藍三種顏色組
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成），每一種顏色的數值，Image J 可分析轉換成為光線強度，以此強度為螢光發射強度。 

三、以自製的螢光光譜儀研究量子點的光學性質 

（一）量子點的螢光 

1. 產物量子點，在紫外光可見光的最大吸收波長是 340 奈米，而紫外燈光源，只有 365 奈米

此單一波長，作為激發光，但不會影響量子點螢光最大放射光波長位置。這是因為碳量子點

其特性就是照射不同波長的激發光（波長範圍在 325-400 奈米），其螢光最大放射波長位置幾

乎不會改變〔5〕。  

2. 透析純化後所得的量子點，照射紫外燈（波長 365 奈米），會發射藍色螢光，以自製的螢光

光譜儀，數位相機的拍攝圖片（圖七十八），既不是單色光也不是有間隔線光譜，是藍光（有

深藍色與淡藍色）與綠光的連續色帶（很像眉月），色帶在下方明顯，上方越來越弱，這是因

為狹縫與方形試管是平行直立，紫外燈照射方形試管的上方，在方形試管的水平部分，越上

方越接近紫外燈，螢光越強，而在方形試管底部，離紫外燈遠，螢光最弱，因為光線直線前

進，才會使相機拍攝相片是下方色帶明顯，但上方色帶弱。 

  

圖七十八 螢光分光照片 圖七十九 螢光光譜圖 

3. 以 Image J 影像分析色帶相片，得螢光光譜如圖七十九，量子點發射螢光最大強度的波長 

在 450 奈米，再與螢光光譜儀（Hitachi F-7000 Fluorescence Spectrophotometer）測得最大螢光放 

 

圖八十 量子點光譜圖(—:市售光譜儀 —:自製光譜儀) 
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射波長在 460 奈米（圖六十八），將兩者的螢光光譜，一起疊圖比較（圖八十），最大放射波

長非常接近，幾乎很一致，說明我們自製的螢光光譜儀很準確，可以用來測量螢光物質的放

射波長所在位置的儀器。 

4. 在圖七十九裡，光譜呈現寬胖的波形，表示產物量子點，是有多種不同奈米尺寸粒徑的粒

子組成的混合物，才會有不同波長的放光，呈現在光譜的圖形裡就會寬胖的，不像特定波長

的線光譜。其實在分光後（圖七十八），就有藍光與綠光的色帶，藍光占的色帶部分多（約占

5/6），綠光緊接在藍光旁且色帶部分少（約占 1/6），推測放出藍色螢光的這一範圍粒徑大小的

量子點多，放出綠光的這一範圍粒徑大小的量子點含量少。 

（二）量子點濃度的螢光效應 

純水稀釋量子點成不同比例，由圖六十九說明，以稀釋成 1/50 比例量子點濃度的螢光強

度最強，而不是稀釋成 1/10 比例量子點濃度，因為量子點濃度高時，量子點會聚集成巨大的

粒子，不再是奈米尺寸，可能無法發出螢光，或是自吸收影響。而當量子點稀釋比例 1/100、

1/200、1/500 濃度時，量子點的濃度減少，發光的量子點減少，螢光強度隨之降低。而稀釋

1/50 比例量子點濃度也做為紫外光可見光譜圖、廷得耳效應與量子點螢光性質時所配置的濃

度依據。 

（三）量子點在不同溶劑的螢光效應 

1. 將稀釋成 1/25 量子點一半體積與另一半等體積不同種類的溶劑裡，有酒精、鹽酸、氫氧化

鈉與鉛離子，由圖七十的螢光光譜，我們發現，在酒精溶液裡，螢光強度會增強，這是因為

量子點是由有機物檸檬酸與乙二胺合成的，屬於有機的量子點，在與有機溶劑分子作用下，

螢光強度是增強的。 

2. 在圖七十中我們發現，鹽酸 HCl 對量子點發光影響最大，會降低螢光強度，氫氧化鈉 NaOH

的影響其次，因量子點是由有機物（檸檬酸與乙二胺）合成，推測在量子點表面可能有胺根 

 

圖八十一 量子點表面推測圖 

與酸根（圖八十一），當在鹽酸濃度為 0.1M 的環境，鹽酸的氫離子會與量子點結合，所以在

鹽酸濃度為 0.1M 與氫氧化鈉濃度為 0.1M 的環境，螢光強度下降這麼多，也可以從相機拍攝

的照片圖二十八與圖二十九，幾乎看不太到螢光。 

3. 由於硝酸鉛溶液中的鉛離子是屬於重金屬，我們是隨機選擇的一種重金屬與量子點反應，

螢光也會下降，表示鉛離子也會影響量子點的螢光。 

（四）量子點在酸性、鹼性環境中的螢光效應 
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1. 為研究量子點在不同濃度的鹽酸 HCl 溶液的螢光（圖七十一），我們配置不同濃度的鹽酸，

與量子點等體積混合成濃度分別為 0.1M、0.01M、0.001M 與 0.0001M，但以廣用試紙，測溶液

的 pH 值卻為 1、5、7、8，這表示產物量子點在稀釋成 1/50 濃度時，溶液可能呈鹼性，在鹽

酸濃度為 0.1M 時，溶液 pH 值可達我們所預期，螢光強度降低許多，但在鹽酸濃度為 0.01M

時，溶液 pH 值為 5，溶液為酸性，螢光強度弱；當鹽酸濃度為 0.001M 時，溶液 pH 值為 7，

溶液為中性，螢光強度也是弱，但有增強趨勢；當鹽酸濃度為 0.0001M 時，溶液 pH 值為 8，

溶液為弱鹼性，螢光強度有恢復成原來強度趨勢，此時鹽酸中的氫離子可能無法影響量子點

螢光。 

2. 為研究量子點在不同濃度的氫氧化鈉 NaOH 溶液的螢光（圖七十二），我們配置不同濃度的

氫氧化鈉，與量子點等體積混合成濃度分別為 0.1M、0.01M、0.001M 與 0.0001M，但以廣用試

紙，測溶液的 pH 值卻為 10、9、8、7，在氫氧化鈉濃度為 0.1M 時，溶液 pH 值雖然沒達到我

們所預期，螢光強度降低許多，但在氫氧化鈉濃度為 0.01M 時，溶液 pH 值為 9，螢光強度弱；

當氫氧化鈉濃度為 0.001M 時，溶液 pH 值為 8，溶液為弱鹼性，螢光強度已逐漸恢復原來強

度；當鹽酸濃度為 0.0001M 時，溶液 pH 值為 7，溶液為中性，螢光強度恢復成原來強度。 

3. 為了解量子點在酸鹼環境改變時，螢光是否會有改變，先取稀釋 1/25 量子點 5mL，加入

〔NaOH〕=0.4M，2.5mL，再加入〔HCl〕=0.4M，2.5mL，即量子點的濃度與量子點稀釋成 1/50

是一樣的，溶液中的氫氧化鈉與鹽酸莫耳數是相同的，在酸鹼中和後，溶液以廣用試紙測其

pH 值=10，說明此時溶液為鹼性，螢光強度由 76 降低到 30，如圖七十三，而後再以滴管逐滴

滴入鹽酸於該溶液，每滴一滴，以廣用試紙測其 pH 值，直到溶液 pH 值等於 7，測螢光強度

為 65，螢光強度又逐漸恢復。 

從 1-3 點的討論，加入鹽酸或氫氧化鈉溶液濃度 0.1M 時，螢光就會降低到分光器看不到光點，

說明在量子點不能再太酸或太鹼的環境。量子點的螢光會受到溶液 pH 值的影響，只能在 pH

值 5 到 9 環境，才能有螢光，調整溶液 pH 值 7，螢光才會恢復。 

（五）量子點在不同鹽類離子溶液的螢光效應 

1. 量子點在多種不同鹽類溶液裡，其螢光光譜如圖七十四，從螢光強度分成兩類，一類是螢

光強度不變，甚至螢光強度增強者，有氯化鈉 NaCl、硫酸銨(NH4)2SO4、氯化鈣 CaCl2、硝酸鉀

KNO3與氯化鋇 BaCl2，他們都有共同的特色，就是被歸類離子強度比較強的鹽類，可能量子 

點表面有帶電，離子與量子點表面作用，使螢光強度增強；另一類螢光強度會降低者，有硝 

酸鉛 Pb(NO3)2、硫酸亞鐵 FeSO4、硫酸鋅 ZnSO4與硫酸銅 CuSO4，他們是屬於重金屬鹽類，除 

了量子點在硫酸鋅溶液螢光強度增強外，量子點在硫酸銅溶液中，螢光強度是所有實驗的鹽

類，降低最多，螢光很弱，在照片的色帶，幾乎看不到，這種螢光減弱的現象，我們稱之為

淬滅，即硫酸銅的銅離子會淬滅量子點。推測如圖八十二
〔13〕

的模型，量子點的表面，可能有

帶電的酸根和胺根，與銅離子作用結合，形成巨大的粒子，以離心機快速旋轉，巨大粒子在

高速旋轉下，會沉到底部，巨大的粒子不再是 1-100 奈米尺寸，可能無法發出螢光，如圖七
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十六的光譜圖，上層液的粒子小，下層液粒子大，所以上層液的螢光（螢光強度=30）會比下

層液（螢光強度=27）較亮，符合我們的推論。 

 

圖八十二 量子點與銅離子結合示意圖 

 

2. 將量子點放入不同濃度的硫酸銅溶液，測其螢光，得螢光光譜（圖七十五），以不同濃度

的硫酸銅為橫坐標，量子點螢光強度為縱座標作圖得圖八十三，線性方程式y=-100.82x + 59.377，

表示螢光減弱有直線斜率負值關係，當銅離子濃度增加，螢光減弱，是一種濃度的淬滅。 

 

圖八十三 銅離子淬滅量子點 

柒、結論 

1. 量子點的取得是以檸檬酸與乙二胺為反應物，其中檸檬酸是提供形成量子點主要原子碳的

來源，乙二胺則是提供氮原子，水為溶劑，反應的條件 150℃、2.5 小時，反應時的容器高壓

釜，以水熱法合成，產物為黑褐色液體。 

2. 以透析膜純化產物 24 小時，得較為清澈黑褐色液體，稀釋成 1/50，有廷得耳效應說明產物

y = -100.82x + 59.377 
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粒徑在 1-100 奈米，及在紫外燈照射，發射非常強的藍色螢光，證明產物是量子點而且會發

出螢光。 

3. 量子點的紫外光可見光光譜最大吸收波長為 340 奈米，而研究機構的螢光光譜儀測得螢光

最強放射波長為 460 奈米，與文獻報導中一致，是典型以碳原子組成量子點特有的光譜波長，

又稱為碳量子點。 

4. 市售牙膏盒為光柵基座、空白 DVD 片為光柵，應用光的繞射，製作穿透式分光器，接上

數位相機，就成為分光接收器。以省電螺旋燈泡發出白光在經過分光器，數位相機拍攝數條

線光譜，結合電腦軟體 Image J 分析影像與軟體 Excel，校正光譜波長。再將樂高積木製成的

樣品槽、紫外燈與分光接收器三者在互相垂直的位置，就為自製螢光光譜儀。 

5. 自製螢光光譜儀測得量子點其最大放射波長為 450 奈米，與實際值 460 奈米非常接近，這

說明自製的螢光光譜儀不但能準確測量螢光物質的光譜波長，並且不需很高花費與時間。 

6. 紫外燈波長 365 奈米照射量子點，分光接收器拍得照片中，有藍色與綠色色帶，說明產物

量子點不是單一尺寸粒徑，是不同粒徑組成混合物粒子。 

7. 以自製螢光譜儀探討量子點的螢光性質，發現量子點會受到環境影響，當溶液中含有： 

（1）有機溶劑，如酒精，螢光強度有增加，可能是量子點從有機物合成的，有機會，可以再

試試其他可與水互溶的有機溶劑。 

（2）氫氧化鈉 0.1M 或鹽酸 0.1M，螢光減弱許多，在分光接收器機幾乎看不到光點，只有在

螢光光譜圖的螢光強度才有數值，溶液中的 pH 值小於 5 或大於 9，螢光很弱，說明量子點不

可在太酸或太鹼的環境，否則看不到螢光。當量子點在有加入酸或鹼時，螢光減弱，調整溶

液 pH 值約在 7 附近時，螢光才會逐漸恢復。 

（3）常見離子強度高的鹽類，如氯化鋇、硫酸銨、氯化鈣與硝酸鉀，量子點螢光強度不變或

增強，推測量子點表面與離子作用造成。 

（4）重金屬鹽類，硝酸鉛、硫酸亞鐵與硫酸銅都會使量子點螢光減弱，以硫酸銅最多，在分

光接收器機幾乎看不到光點，只有在螢光光譜圖的螢光強度才有數值，稱此一現象為銅離子

淬滅量子點，推測量子點結構與銅離子有作用，使螢光機制改變，並且這種淬滅是為濃度淬

滅。 

8. 本次的研究裡，我們探討螢光發光的粒子為量子點，就為題目的「量點」，而另一「亮點」，

則是所合成的量子點會發光，就稱之為「亮點」，並且，還有另一個「亮點」，就是自製螢光

光譜儀。以簡單的用品，牙膏盒、光碟片與樂高積木組合成簡易的螢光光譜儀，就可測得量

子點的螢光放射波長，與研究機構所用的螢光光譜儀測得波長，非常接近，準確度很高，未

來也可以對其他發光物的研究，倘若無螢光光譜儀，也可以自製螢光光譜儀，做初步的探討。 
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作品海報 

【評語】030209  

本作品從合成碳量子點，檢測螢光光譜、調控光譜的遲緩效應

等進行，作品完整，品質優異。此外，作者自製螢光光譜儀，了解

其原理，精神可嘉值得鼓勵。惟作者可再進一步了解碳量子點發光

的原理係來自碳核或碳表面？可以查一查論文。另外，螢光受酸鹼

遲緩的原因值得探討，究竟來自電子轉移或者能量轉移，如何轉

移？ 

F:\中小科展_57屆\排版\030209-評語 



摘要 

    量子點以水熱法合成，反應物是檸檬酸與乙二胺，反應條件

為 150℃、2.5 小時，經透析膜純化後，得黑褐色液體。有廷得耳

效應，紫外光可見光譜最大吸收波長 340 奈米，而在紫外燈下，

會發出藍色螢光，且螢光放射波長 460 奈米，是以碳為主要組成

原子的量子點。利用牙膏盒、空白 DVD 片、數位相機、積木與紫

外燈，結合電腦軟體 Image J 分析影像與 Excel，自製螢光光譜儀，

可測得量子點螢光放射波長 450 奈米，非常接近實際值。再以自

製螢光光譜儀研究，發現量子點在含酒精或離子強度強的鹽類水

溶液，如氯化鋇、氯化鈣，螢光強度會增強；水溶液 pH 值小於 5

或大於 9 或在硫酸銅溶液螢光會降低，故需調整溶液 pH 值在 7 附

近，使螢光恢復。 

壹、研究動機 

    老師在介紹「光」這個單元時，說明發光體有太陽、燭光、

螢光、…等，其中「螢光」，不像太陽與燭光有光也有熱，並非主

動發光體，而是「光致發光」，本身並不放出熱量，所以是一種冷

發光。當某種常溫物質經某種波長（紫外光或 X 光）的入射光照

射，在吸收能量較高的光源後，電子會產生能階躍升，而當電子

從高能階的狀態降到低能階的狀態時，立即退激發並發射出波長

較長的光（通常波長比入射光的的波長長，在可見光波段，螢光

發光機制如圖一）；而且一旦停止入射光，發光現象也隨之立即消

失。近年來的文獻報導，有一種會產生「螢光」的材料，稱為「量

子點」，由少量的原子所構成，其尺寸都在 100 奈米(nm)以下，

外觀恰似一極小的點狀物，是一種奈米級材料，在吸收能量較

高的紫外線光源後，會發射出波長較長的光，如圖二，利用單一

波長的紫外光燈源，便可以激發出多種不同波長的光波之特性，

且可重複激發，因此螢光時效可以持久。這些特性吸引對「量子

點」的發光很好奇，翻閱文獻，我們想用簡易的方法，合成出「量

子點」，並以現有的器材，利用螢光偵測原理，設計簡易螢光光譜

儀，研究「量子點」的螢光性質。 

  

      圖一 螢光發光機制                圖二 硒化鎘量子點螢光
〔1,2〕

 

貳、研究目的 

一、量子點的合成 

二、製作簡易螢光光譜儀 

三、量子點的光學性質研究 

四、以自製螢光光譜儀測量分析量子點在不同溶劑、酸性、鹼性

及金屬離子溶液的螢光光譜 

參、研究設備及器材 

一、研究設備 

電子天平、攪拌加熱器、壓力釜、樣本瓶、紫外燈、滴管、雷射

筆、空白 DVD、剪刀、脫脂棉花、牙膏盒、黑色膠帶、方形玻璃

試管、廣用試紙、樂高積木、透析膜、攪拌子、數位照相機、影

像分析軟體 Image J、數據分析軟體 Excel、離心機、離心管 

二、研究藥品 

檸檬酸、乙二胺、氯化鈣、硝酸鉀、氯化鋇、六水合硫酸銨亞鐵、

硫酸銅、硫酸銨、氯化鈉、硝酸鉛、硫酸鋅、R.O 逆滲透水 

肆、研究過程或方法 

我們將實驗分成三部分，分別為量子點的合成、製作簡易螢光光

譜儀及量子點性質的研究： 

一、量子點的合成 

（一）量子點的合成 

近年來，合成量子點有多種方法，雷射剝蝕法、化學合成、熱分

解、微波法和水熱法，其中，本次的研究是採用水熱法。水熱法

是指反應於高壓釜中進行，將反應物（檸檬酸與乙二胺）配置成

水溶液在密閉容器內，利用油浴鍋及加熱板，可將溫度調至數百

度，隨著對高壓釜加熱，釜內的溫度的

上升並且壓力增加（如圖三）。水溶液在

高壓、高溫的環境，就能促使水溶液中

含碳的物質反應生成量子點（式一），由

於不經過高溫煅燒，可避免量子點再次

聚集，變成巨大碳粒〔3,4,8〕。 

（二）量子點的純化 

 1.透析原理：本次量子點的純化，

是利用透析膜，透析膜的外觀很

像塑膠袋，透析膜的原理，是利

用分子會從高濃度擴散到低濃

度，待透析放在具分子大小選擇

性的透析膜中，進行物質交換，

此時大分子的溶質會被保留，而

小分子溶質會通過透析膜移除，

最終達到去除的效果（圖四）。 

2.透析過程 

○1 ○2 ○3  

○1 量取透析膜長度 10 公分並剪下 

○2 以寬 3 公厘捲三層，夾子夾住，再倒入產物黑褐色液體 

○3 燒杯裝逆滲透的水，放入透析膜，以攪拌器攪拌，透析 24 小時 

二、自製螢光光譜儀製作 

（一）穿透式分光器的製作 

○1 ○2 ○3  

○4 ○5 ○6  

○1 牙膏盒在中點處，量角器量取 60°斜角，以美工刀切割成兩部分 

○2 右半部分市售牙膏盒轉成另一方向 

○3 全新空白 DVD 光碟片，以剪刀將 DVD 剪開，把 DVD 分開 

○4 要的是塗有紫色染料透明塑膠那一片，棉花沾酒精把染料除去 

○5 在該牙膏盒頂端平面，以美工刀劃開一寬 0.5mm，長 2.5cm 狹縫 

○6 另一部分的牙膏盒，剪去頂端部分的盒蓋，開口端以斜角 60°，

與開口端斜角 60°相接，以黑色膠帶固定黏好，避免漏光，原來長

方型的牙膏盒，即為呈 120°的夾角的穿透式分光器 

（二）校準光譜儀〔6,7〕 

 

○1  

  

○2  

 

○3  

○1  開啟影像分析軟體 Image  J 

○2 在 File 處，選擇 Open，開啟省

電燈泡之色帶照片 

○3 使用矩形工具，選取一長方形

範圍，設定矩形位置及大小ˋ 

○4 再次選取工具列 Analyze、Plot 

Profile，工具列中，選 Analyaze、

Tools、Curve Fitting，就可以將

橫坐標的位置像素轉換成波長。 

○5 開啟另一軟體 Excel，將數據貼上，得省電燈泡光譜圖（圖五）  

 
圖五  省電燈泡光譜圖 

（式一） 

 

圖三 水熱法 

圖四 透析原理
〔5〕

 

 

○4  

https://zh.wikipedia.org/wiki/%E5%8F%AF%E8%A7%81%E5%85%89
https://zh.wikipedia.org/w/index.php?title=%E7%A1%92%E5%8C%96%E9%95%89&action=edit&redlink=1
https://zh.wikipedia.org/w/index.php?title=%E7%A1%92%E5%8C%96%E9%95%89&action=edit&redlink=1


（三）自製螢光光譜儀 

○1  

 

○2  ○3  

○1 自製螢光光譜儀示意圖 

○2 分光器接在數位相機的鏡頭前 

○3 照光光源為紫外燈，分光器連接數位相機為偵測器，拍攝螢光分光後色帶 

三、量子點性質的研究 

（一）量子點在紫外光可見光光譜儀的測量 

（二）市售螢光光譜儀測量量子點的螢光放射光譜 

（三）量子點在紫外燈下的螢光 

（四）以雷射光說明量子點的廷得耳效應 

（五）以自製螢光光譜儀測量分析量子點在不同稀釋比例、溶劑、酸性、鹼

性及金屬離子溶液之螢光特性 

○1 ○2 ○3 ○4  

○5 ○6 ○7 ○8  

○1 量子點稀釋成 1/10、○2 量子點稀釋成 1/50、○3 量子點稀釋成 1/100、○4 量

子點稀釋成 1/200、○5 量子點稀釋成 1/500、○6 量子點在酒精中、○7 量子點在

0.1MHCl 中、○8 量子點在 0.1MNaOH 中 

○9 ○10 ○11 ○12  

○13 ○14 ○15 ○16  

○9 量子點在 0.1MPb(NO3)2中、○10量子點在 0.01MHCl 中、○11量子點在 0.001MHCl

中、○12量子點在 0.0001MHCl 中、○13量子點在 0.01MNaOH 中、○14量子點在

0.001MNaOH 中、○15量子點在 0.0001MNaOH 中、○16量子點在酸鹼中和後 pH=10 

○17 ○18 ○19 ○20  

○21 ○22 ○23 ○24  

○17量子點在酸鹼中和後加酸至 pH=7、○18量子點在 0.1MNaCl 中、○19量子點在

0.1MCuSO4中、○20量子點在 0.1MZnSO4中、○21量子點在 0.1MFeSO4中、○22量子

點在 0.1M(NH4)2SO4中、○23量子點在 0.1MCaCl2中、○24量子點在 0.1MKNO3中 

○25 ○26 ○27 ○28  

○29 ○30 ○25量子點在 0.1MBaCl2中、○26量子點在

0.05MCuSO4中、○27量子點在0.01MCuSO4中、○28量子點在0.1MCuSO4中上層液、

○29量子點在 0.1MCuSO4中中層液、○30量子點在 0.1MCuSO4中下層液 

伍、研究結果 

一、量子點的合成 

（一）產物、純化後證明是否有螢光 

○1 ○2 ○3 ○4  

○1 產物在日光下、○2 產物在黑暗處照射紫外燈○3 產物左瓶已透析、右瓶未透 

析（在日光）○4 產物左瓶已透析、右瓶未透析（在紫外燈下） 

（二）證明產物在純化後是量子點之螢光物質 

1. 量子點的紫外光可見光光譜圖 

 

2. 量子點螢光放射光譜圖 

 

3. 照射紫外燈 365 奈米 

 

4. 量子點的廷得耳效應 

 

二、量子點性質研究之螢光光譜 

 
圖六 不同稀釋比例的量子點螢光光譜圖         圖七 量子點在不同溶劑的螢光光譜 

 

圖八 量子點在不同酸性濃度的螢光光譜         圖九 量子點在不同鹼性濃度的螢光光譜 

圖十 量子點在酸鹼中和前後的螢光光譜       圖十一 量子點在不同鹽類溶液的螢光光譜 

 
圖十二 量子點在不同濃度硫酸銅溶液的

螢光光譜 

 
圖十三 量子點與硫酸銅之混合溶液在離心機離

心後的螢光光譜 

陸、討論 

一、量子點的合成 

（一）量子點的合成 

1. 為了能控制量子點的尺寸及有較高的量子產率，以檸檬酸與乙二胺為反應

物，檸檬酸（C6H8O7）是碳的提供者；乙二胺（C2H4(NH2)2）含氮，為合成量

子點上缺陷時提供的氮，選用水熱法合成，使用高壓釜，可以提供反應時的

固定高溫、高壓。本次的反應條件為 150℃高溫 2.5 小時，反應物原先是無色

溶液，產物為黑褐色液體，產物在日光照射下，在濾紙上是淡黃色，並沒有 
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螢光；在黑暗處以紫外燈照射，而產物可發出強度高的藍光螢光，

證明產物具有螢光物質。 

2. 量子點的顆粒大小為 1-100 奈米，而產物顆粒有大有小，有可能

也有未完全反應的起始物，使用透析膜 Spectrum 500-1000 純化。 

3. 比較產物在透析前後，在日光下，外觀都是黑褐色，有透析的

產物，比較清澈；而在紫外燈下，有透析的產物，螢光較亮，表

示影響螢光發光物質已移除。 

（二）證明合成產物是量子點之螢光物質 

1. 以紫外光可見光的光譜儀所測的量子點吸收光譜圖，其最大的

吸收波長為 340 奈米與文獻的報導〔4〕是一致的。以 340 奈米此波

長作為激發光波長，螢光光譜儀測其螢光最強放射波長為 460 奈

米，也與文獻的報導〔3,4〕最強的放射波長 454 奈米是一致的。光譜

波長證明合成的產物是典型的以碳為主要構成原子之碳量子點。 

2. 在紫外燈下產生的螢光 

    產物在稀釋 1/50 後，與純水一起比較，照射紫外燈，只有產

物可發出藍色的螢光。 

3. 量子點的廷得耳效應觀察 

    綠色雷射光照射水與產物，產物有黃色光束，證明所合成產

物為膠態溶液，含有 1-100 奈米的粒子存在，就為量子點。 

二、自製簡易螢光光譜儀製作 

（一） 螢光偵測器的製作 

自製分光器以牙膏盒斜切，放入光柵，另一斜切部分反接，

光柵是空白 DVD 其中透明片，是聚碳酸酯層凹槽，凹槽的溝槽間

距=720 奈米，當一白光由狹縫進入，經光柵繞射，就可以觀測到

由左到右，分別為藍光、綠光、黃光與紅光數條光譜譜線，而在

另一開口端接上數位相機，就能記錄此光譜。螢光的偵測原理，

照光與螢光兩者互相垂直，並在螢光發射處，放置螢光偵測器，

其偵測器是由自製分光器連接數位相機組成。再將拍攝到的影像，

輸入電腦影像處理 Image J 軟體。 

（二） 校正光譜 

省電螺旋燈泡發出的白光來校正光譜，白光經分光器，會發

射出數條特定譜線（線光譜），其影像輸入 Image J 軟體，會得到

橫坐標為位置像素，縱座標為光線強度的光譜圖，最左端藍色光

譜線，波長 436.6nm；最右端紅色光線，波長 611.6nm，這兩條線

所在位置像素值轉換成波長數值，作圖得已校準波長其橫坐標為

波長，縱座標為強度之省電燈泡之光譜圖，所有樣品，皆以省電

燈泡的光譜，定出光譜波長所在位置。每一種顏色的數值，Image J

可分析轉換成為光線強度，為螢光發射強度。 

三、量子點的光學性質 

（一）量子點的螢光 

1. 產物量子點，在紫外光可見光的最大吸收波長是 340 奈米，而

紫外燈光源，只有 365 奈米此單一波長，作為激發光，但不會影

響量子點螢光最大放射光波長位置。這是因為碳量子點，其特性

就是照射不同波長的激發光（325-400 奈米），其螢光最大放射波

長位置幾乎不會改變〔4〕。  

2. 分析色帶相片，量子點發射螢光最大強度的波長在 450 奈米，

與螢光光譜儀測得最大螢光放射波長在 460 奈米差不多，很一致，

說明我們自製的螢光光譜儀很準確，是可以用來測量螢光物質的

放射波長所在位置。 

 

圖十四  螢光光譜圖 

 

圖十五 量子點光譜圖(—:市售光譜儀 —:自

製光譜儀) 

（二）量子點濃度的螢光效應 

量子點以稀釋成 1/50 比例量子點濃度的螢光強度最強，量子

點濃度高時，量子點會聚集成巨大的粒子，不再是奈米尺寸，可

能無法發出螢光，或是自吸收影響。而當量子點的濃度減少，發

光的量子點減少，螢光強度隨之降低。 

（三）量子點在不同溶劑的螢光效應 

1. 在酒精裡，螢光強度會增強，這是因為量子點是由有機物檸檬

酸與乙二胺合成的，屬於有機的量子點，在與有機溶劑分子作用

下，螢光強度是增強的。 

2. 鹽酸 HCl 對量子點發光影響最大，會降低螢光強度，氫氧化鈉

NaOH 的影響其次，因量子點是由有機物合成，推測在量子點表面

（圖十六）可能有胺根與酸根，當在鹽酸濃度為 0.1M 的環境，鹽

酸的氫離子會與量子點結合，幾乎看不太到螢光。 

（四）量子點在酸性、鹼性環境中的螢光效應 

量子點在酸鹼中和後，溶液以廣用試紙測其 pH 值=10，說明此時

溶液為鹼性，螢光強度降低，再加入鹽酸於該溶液直到溶液 pH 

值等於 7，測螢光強度又逐漸恢復。量子點不能在太酸或太鹼的 

環境。量子點的螢光會受到溶液 pH 值的影響，只能在 pH 5 到 

9 環境，才能有螢光。 

（五）量子點在不同鹽類離子溶液的螢光效

應 

1. 量子點在氯化鈉 NaCl、硫酸銨(NH4)2SO4、

氯化鈣 CaCl2、硝酸鉀 KNO3與氯化鋇 BaCl2，

被歸類離子強度比較強的鹽類，可

能量子點表面有帶電，離子與量子

點表面作用，使螢光強度增強；另

一類螢光強度會降低者，有硝酸鉛

Pb(NO3)2、硫酸亞鐵 FeSO4與硫酸銅

CuSO4，他們是屬於重金屬鹽類，

量子點在硫酸

銅溶液中，螢

光強度是降低

最多。我們稱

之為硫酸銅的

銅離子會淬滅

量子點。推測

的模型，量子

點的表面，可能有帶電的酸根和胺根，與銅離子作用結合，形成

巨大的粒子，以離心機快速旋轉，巨大粒子在高速旋轉下，會沉

到底部，巨大的粒子不再是 1-100 奈米尺寸，可能無法發出螢光，

上層液的粒子小，下層液粒子大，所以上層液的螢光會比下層液

較亮，符合我們的推論。 

柒、結論 

1. 量子點以檸檬酸與乙二胺為反應物，水為溶劑，反應的條件 150

℃、2.5 小時，反應時的容器高壓釜，以水熱法合成，產物為黑褐

色液體。 

2. 以透析膜純化產物 24 小時，稀釋成 1/50，有廷得耳效應說明產

物粒徑在 1-100 奈米，及在紫外燈照射，發射非常強的藍色螢光，

證明產物是量子點而且會發出螢光。 

3. 量子點的紫外光可見光光譜最大吸收波長為 340 奈米，而研究

機構的螢光光譜儀測得最強放射波長為 460 奈米，是碳量子點特

有的光譜波長。 

4. 以簡易物品，應用光的繞射，製作穿透式分光器，接上數位相

機，就成為分光接收器。以省電螺旋燈泡發出白光在經過分光器，

數位相機拍攝數條線光譜，結合電腦軟體 Image J 分析影像與軟體

Excel，校正光譜波長。再將樂高積木製成的樣品槽、紫外燈與分

光接收器三者在互相垂直的位置，就為自製螢光光譜儀。 

5. 自製螢光光譜儀測得碳量子點其最大放射波長為 450 奈米，與

實際值 460 奈米非常接近，說明自製的螢光光譜儀能準確測量螢

光物質的光譜波長。 

6. 以自製螢光光譜儀探討量子點的螢光性質，發現量子點的螢光

會受到環境影響，溶液中含有：（1）有機溶劑，如酒精，螢光強

度有增加。（2）溶液中的 pH 值小於 5 或大於 9，螢光很弱，當量

子點在調整溶液 pH 值約在 7 附近時，螢光才會逐漸恢復。（3）常

見離子強度高的鹽類，如氯化鋇、硫酸銨，量子點螢光強度不變

或增強，推測量子點表面與離子作用造成。（4）硫酸銅會使量子

點螢光減弱，稱此一現象為銅離子淬滅量子點，推測量子點結構

與銅離子有作用，使螢光機制改變，並且這種淬滅是為濃度淬滅。 

7. 探討螢光發光的粒子為量子點，就為「量點」，而另一「亮點」，

則是所合成的量子點會發光，就稱之為「亮點」，並且，還有另一

個「亮點」，就是自製螢光光譜儀，可測得量子點的螢光放射波長，

與螢光光譜儀測得波長，非常接近，準確度很高。 
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圖十七 銅離子淬滅量子點 

 

圖十八 量子點與銅離子結合示意圖 

 

圖十六 量子點表面 
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